
A L P H A  F I V E  V 9  M O D U L E  2  

 

 

Exploring Field Rules 
 Reviewing Field Rules 

 Using Expressions and Conditions 

 Assigning Data Entry Formatting 

 Using Lookup Tables 

 



E X P L O R I N G  F I E L D  R U L E S  

©2008 Intellectual Business Solutions, Inc.  16 

 

Module Objectives 

Reviewing Field Rules 
 In the Alpha Five v9, Level 1 course, you learned how to access the Field Rules 

Editor and set field rules such as auto-incrementing fields, setting a default 
value for a field, and defining a simple list lookup for a field. In this section, you 
will review these features.   

Using Expressions and Conditions 
 Alpha Five gives you the ability to build simple expressions and complex 

calculations to evaluate, display, and determine the value for a field. The 
expression can be composed of functions, literal strings, and operators. You can 
use the DATE() function as the default value for a date field where you want 
the system date to automatically be stored. In addition, you can program 
specific fields to be required or conditionally required. 

Assigning Data Entry Formatting 
 You can build input masks to regulate the form and content of field data. Alpha 

Five has several built-in simple masks for fields that store data such as social 
security numbers, phone numbers, and US and Canadian zip codes. In addition, 
you can create your own custom masks for fields. You can use Transformation 
rules to control letter casing, i.e. uppercase/lowercase during data entry.    

Using Lookup Tables 
 Alpha Five also lets you create lookups of appropriate values for fields that can 

contain only one of a limited selection of entries to control the information 
entered into records. Lookups can be done with simple lists, cascading lists, and 
table lookups. A field can be provided data from a field in another table using a 
lookup table style. In addition, you can also auto-fill other fields in the target 
table based on values in the lookup table. 
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Reviewing Field Rules 
You can define field rules to control the information that can be entered into fields. A 
field can be set to automatically generate a data value in a sequential or patterned 
format. In addition, you can build input masks to regulate the form and content of field 
data. Alpha Five also lets you create lookups of appropriate values for fields that can 
contain only one of a limited selection of entries to control the information entered into 
records.  
 

Field Rules provide the ability to… 

 
 
o Maintain data integrity 
o Change letter casing of field values such as 

names 
o Eliminate spelling errors 
o Use masks to ensure certain types of data are 

entered uniformly 
o Validate data entry such as minimum or 

maximum allowed values 
o Enter default values that can save time and 

ensure information is consistent  

 

o Lookup data from a list or a data table during data entry 
o Ensure that certain fields are required 
o Ensure that no one can deliberately or inadvertently change data 

once it is entered 
o Create calculated fields that evaluate expressions or combine the 

values of multiple fields 
o Employ Xbasic to perform certain actions based upon different events 
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Accessing the Field Rules Editor 
Field Rules are defined using the Field Rule Editor window shown in Figure 1. You can 
access the Field Rule Editor in several ways. From the Control Panel, on the Tables/Sets 
tab, right-click the table containing the field to define and choose Edit Field Rules or 
select the table, click the Design button on the Control Panel toolbar, and choose Field 
Rules from the Design menu. If you are already working in design mode, you can click 
the Field Rules button on the Table Design toolbar.  

Field Rules can be created for use at the table level or at the form level. Form level field 
rules differ from table level fields rules in that field rules are applied only when the 
custom form is in use. A table level field rule is applied whenever the table is in use 
whether it’s used with a form, browse, query, or report. The use of form level field rules 
will be discussed in a later module in the course. 

Figure 1: Field Rules Editor Window - Events Table 
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The Field Rules Editor window contains tabbed pages you use to define a field. The Field 
Rules Editor tabbed pages are described in Table 1. You do not have to make selections 
on all of the tabs, just the ones that you want for the selected field. Each tab consists of 
several options from which to choose for the selected field. Be sure to resize or maximize 
the Field Rules Editor window so that the entire tabs’ contents are visible.   
 

Tabbed Page Description 

Field Types  Used to define field formatting such as auto-incrementing, 
add descriptive field names and descriptions that are 
displayed in forms, browses, and on the status bar. 

Data Entry Used to format, and validate data such as making a field 
required, defining an input mask, and setting field 
advancement. 

Transformations Used to automatically change entries to uppercase or 
lowercase, and define shortcut abbreviations for entering 
commonly used words and phrases. 

Validations Used to ensure data entry accuracy such as requiring a field 
value to be entered twice, field value uniqueness, or a field 
value crosschecked against the value in another table. 

Lookups Used to set field entry based on a selection from either a 
lookup table defined using the Field Rules Editor or from an 
existing table. This option is used with Character, Numeric, or 
Date data type fields. 

Posting Used to set field entry based on the value of a matching 
record in another table. The table to which values are posted 
must have fields in common with the current table. 

Events Used to define an event(s) to be performed for a field or 
record. This process is commonly called “Action Scripting.” 

 
Table 1: Field Rules Editor Window - Tabbed Pages Described 

 

 

To access the Field Rules Editor from the Control Panel: 

1. In the Control Panel window, right-click the table containing the field to define. 

2. From the shortcut menu, choose Edit Field Rules. 

 or 

1. In the Control Panel window, click the table containing the field to define. 

2. On the Control Panel toolbar, click the Design button.  

3. From the Design menu, choose Field Rules. 
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 To access the Field Rules Editor in table design mode: 

1. If necessary, open the table containing the field to define in design mode. 

2. On the Table Design toolbar, click the Field Rules button  

 

 

In the following exercise, you will access the Field Rules Editor for the Events table from 
the Control Panel. 

1. In the Data2 folder on drive C, open 
the Planner2.adb database 

The Planner2.adb database opens. 

2. If necessary, display the Tables/Sets 
tab 

The Table/Sets tab is active in the 
Control Panel. 

3. In the Control Panel window, right-
click the Events table 

A shortcut menu appears. 

4. From the shortcut menu, choose Edit 
Field Rules 

The Field Rules Editor window appears 
for the Events table. The Event_Id field is 
selected and the Field Types tab is active. 
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Auto-Incrementing a Field 
You can use the auto-increment feature to have Alpha Five automatically assign an 
incremented value to a field as new records are added to a table. Auto-increment is 
useful for fields where sequential numbering is needed, such as an identification number 
for an event, attendee number, activity ID, or reservation ID. Auto-increment can be 
defined for character, date, and numeric fields. You can specify the starting value by 
setting a default value for the first record. The next record is assigned an incremented 
value based on the highest value in the table record. This process continues as records 
are added to the table. You use the Field Types tab shown in Figure 2 to define an auto-
incremented field.   

Figure 2: Field Rules Editor Window—Field Types Tab 

 

 

To set a field to auto-increment: 

1. If necessary, open the Field Rules Editor window. 

2. In the Field Rules Editor window, select the field to auto-increment. 

3. On the Field Types tab, select the Auto increment option. 
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In the following exercise, you will set the EVENT_ID field to auto-increment and save the 
changes. 

1. If necessary, select the EVENT_ID 
field 

 

2. Make sure the Field Types tab is 
active 

 

3. On the Field Types tab, select Auto-
increment 

The Auto-increment option is selected. 

 

4. On the Field Rules Editor toolbar, click 

the Save button  
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Setting a Default Value 
If you’ve defined a field as auto-increment, you can enter a default value that will be 
used as the starting value for the first record entered in the table. For example, if you 
want to assign 4-digit Event ID numbers with the starting number of 0001, you would 
enter “0001” in the Default value field. The first new record in the table will be assigned 
Event ID#0001.   

When specifying the default value, you can also choose when the default value is 
entered into the field; at the start of data entry or at the end of entry. You can even 
have the field bypassed for data entry to prevent a user from entering an erroneous 
value. Bypassing a field is done with the “Skip” option on the Data Entry tab. In order to 
“skip” over a field for data entry, you must specify an expression of .T. (true). If you 
choose to “Skip” over a field, you can set the “Auto advance after field filled” option to 
instruct Alpha Five to position the cursor in the next field for data entry. By activating this 
option, the end user doesn’t have to press the ENTER key or the TAB key to advance to 
the next field. 

To set a default value for a field, use the Default mode option on the Data Entry tab 
shown in Figure 3.  There are four types of default modes. The default modes are 
explained in Table 2.  

 

Figure 3: Field Rules - Data Entry Tab 
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Default Mode Description 

No defaults Indicates that a default value has not been assigned to the 
field. (default) 

Simple default 
expression 

Default value is evaluated or calculated with a simple 
expression; i.e. a STATE field can have a default value of 
“MD.” The STATE field for all new records will automatically 
have a value of “MD.” 

Conditional 
default values 

Default value is evaluated or calculated using a conditional 
expression; i.e. in the CUSTOMER.SALES_REP field a field may 
be computed based on the value in the CUSTOMER.STATE 
field. 

Use previous 
value as default 

Default value is set based on the field value of the previous 
record. 

 
Table 2: Field Rules - Data Entry Tab: Default Modes Described 

*Note: Depending on the options chosen on the Data Entry tab, additional fields may 
appear on the tab. Here you can provide additional specifications for the field rule.  
 

 

To set a default value for a field: 

1. If necessary, open the Field Rules Editor. 

2. In the Field Rules Editor, select the field in which to assign a default value. 

3. Click the Data Entry tab. 

4. In the Default mode drop-down list box, select the default mode. 

5. In the Default value field, enter an expression.  

6. Make remaining selections as needed. 

7. Save the changes to the field rules.  

 

 

In the following exercise, you will set default value options for the EVENT_ID field in the 
Events table. In addition, you will also set the default value option for the ATTENDEE_ID 
field in the Attendees table. 

1. In the Field drop-down list box, make 
sure the EVENT_ID field is selected 

 

2. Click the Data Entry tab The Data Entry tab is active. 
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3. In the Default mode drop-down list 
box, select Simple default expression 

The Default mode is set to Simple default 
expression. Additional fields are displayed 
for selection. 

4. In the Default value field, type 
“0001” 

The Default value is set to 0001. 

5. In the Defaults area, click the Set 
default value at start of data entry 
option 

The Set default value at start of data 
entry option is checked. 

6. On the Data Entry tab, click the Auto 
advance after field filled option 

The Auto advance after field filled option 
is checked. 

7. In the Skip field, type .T. The Skip field is set to true. The 
EVENT_ID field will be skipped for data 
entry. 

8. On the Field Rules Editor toolbar, click 

the Save button  

Field rule settings are saved.  

9. On the Field Rules Editor toolbar, click 
the Close button  

The Field Rules Editor window closes. 

10. In the Control Panel on the 
Tables/Sets tab, right-click the 
Attendees table 

A shortcut menu appears. 

11. From the shortcut menu, choose Edit 
Field Rules 

The Field Rules Editor window opens. 
The ATTENDEE_ID field is selected. 
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12. Set the ATTENDEE_ID field to Auto-
increment with a default value of 
“00001” 

 

13. On the Data Entry tab, click the Auto 
advance after field filled option 

The Auto advance after field filled option 
is checked. 

14. In the Skip field, type .T. The Skip field is set to true. The 
ATTENDEE_ID field will be skipped for 
data entry. 

15. On the Field Rules Editor toolbar, click 

the Save button  

The Field Rules settings are saved. The 
Field Rules Editor window remains open. 
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Defining a Field Lookup List 
If your table contains a field for which a limited number of valid entries exist, you can 
create a simple lookup list for that field. For example, when entering a new reservation 
record into the Reservations table, you can use a lookup to display a list of attendee 
types from which to choose. An attendee type can be a staff, regular, speaker, or 
sponsor. A lookup list is a list of appropriate entries for the selected field. When you are 
entering data into a table, choosing a value from a list can be easier than typing in a 
long entry and helps ensure that data is entered exactly as required. A Lookup can be 
defined for a character, numeric, or date field.  To define a lookup list for a field, select 
the Lookups tab in the Field Rules window shown in Figure 4.   

 

Figure 4: Field Rules Editor Window - Lookups Tab: Simple List Style Selected 
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Alpha Five provides five Lookup styles from which to choose for the list. The styles are 
described in Table 3.  Once you select the lookup style, you can make additional 
selections for the lookup list such as the appearance of the list, position of the list, and 
the display of the list.  
 

Lookup Style Function 

Simple list Used to provide a pre-defined list of choices for a 
field. 

Cascading list Used to provide a pre-defined hierarchical structure 
of categorized values from which to choose for a 
field. 

Table lookup List values are provided by a record in another table. 

Conditional table lookup List values are provided by two or more tables from 
which to choose for a field. 

Previous values List values are built based on values already entered 
in previous records’ fields. 

 
Table 3: Lookup Styles Described 

 
You can use the “Allow Exceptions”  field to indicate the values allowed in the lookup 
field and what will happen when an invalid value is entered. The Allow Exceptions 
choices are described in Table 4. 

Allow Exceptions Result 

Allow any value 
(default) 

Allows choices from the lookup as well as entries 
typed during data entry. 

Force closes match Allows only lookup choices. Values that are typed are 
matched to the closest lookup value. 

Pop-up on mismatch Allows only lookup choices. An invalid entry will 
trigger a pop-up window that displays valid lookup 
entries from which to choose. 

 
Table 4: Allow Exceptions Options Described 

*Note: If you want to prevent a lookup list value from being replaced with an invalid 
entry, you can set the “Skip” option to true. You can also define a lookup to 
simultaneously fill any other field in the table. This topic will be covered later in the 
module. 
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To define a field lookup list: 

1. If necessary, open the Field Rules Editor window. 

2. In the Field Rules Editor window, select the field to define a lookup. 

3. On the Lookups tab, select the Lookup style for the field. 

4. Complete the Lookups tab as needed. 

5. Save the changes to the Field Rules. 

 

In the following exercise, you will define a field lookup list for the ATTENDEE_TYPE field in 
the Reservations table. 

1. In the Control Panel window, right-
click the Reservations table 

A shortcut menu appears. 

2. From the shortcut menu, choose Edit 
Field Rules 

The Field Rules Editor window appears. 

3. In the Field drop-down list box, select 
the ATTENDEE_TYPE field 

 

4. In the Field Rules window, click the 
Lookups tab 

The Lookups tab is active. 

 

5. In the Lookup styles drop-down list 
box, select Simple list 

Additional lookup options are displayed. 

6. In the first ATTENDEE_TYPE lookup 
cell, type Regular 

 

7. In the second ATTENDEE_TYPE 
lookup cell, type Staff 

 

8. Complete the entries as follows: 
Speaker 
Sponsor 
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9. In the Allow exceptions drop-down list 
box, select Popup on mismatch 

 

10. On the Field Rules Editor toolbar, click 

the Save button  
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Using Expressions and Conditions 
Alpha Five gives you the ability to build simple expressions and complex calculations to 
evaluate, display, and determine the value for a field. The expression can be composed 
of functions, literal strings, and operators.  

Using the DATE() Function in an Expression 
If you would like a field to have or reference a common value such as a preset date the 
same value whenever you add new data to a table, you can set a default value to 
appear in the field when you add a record. For example, working in the Reservations 
table, you might set the default value of the RESERVATION_DATE field to be the current 
date (See Figure 5). Once you do this, Alpha Five automatically enters the current date 
into the field whenever you enter a new reservation into the table.  

To enter the current date into a field, you can use a function. A function is a predefined 
procedure that calculates a value. Many functions that perform a variety of calculations 
are available for use when you work in Alpha Five. In the example discussed above, you 
can use the Date() function to define the default value. The Date() function 
automatically enters the current date, as stored in your computer.  

 

Figure 5: Field Rules - Data Entry Tab for RESERVATION_DATE Field 
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 To enter a simple expression: 

1. If necessary, open the Field Rules Editor. 

2. In the Field Rules Editor, select the field in which to enter a simple expression. 

3. Click the Data Entry tab. 

4. In the Default mode drop-down list box, select simple default expression. 

5. In the Default value field, enter an expression. 

6. Make remaining selections as needed. 

7. Save the changes the Field Rules.   

 

 

In the following exercise, you will set default value options for the RESERVATION_DATE 
field. You will also set the RESERVATION_NO field to auto-increment with a default value 
of “00001”. 

1. In the Field drop-down list box, select 
the RESERVATION_DATE field 

 

2. Click the Data Entry tab The Data Entry tab is active. 

3. In the Default mode drop-down list 
box, select Simple default expression 

The Default mode is set to Simple default 
expression. Additional fields are displayed 
for selection. 

4. In the Default value field, click the 
Expression Builder button  

The Expression Builder (Date) window 
opens. 

5. In the Expression Builder (Date) 
window, select Function 

 

6. Choose  The Function Finder window appears. 

7. In the Category drop-down list box, 
select Date 

A list of Alpha Date functions appear. 

8. From the Date functions list area, 
select date() 

The date() function appears in the Select 
Function text box. 

9. Choose  The Function Finder window closes. In 
the expression area, date( appears. 
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10. In the Expression Builder window, 
type ) 

The expression is complete and displays 
the date() function. 

11. In the Expression Builder (Date) 
window, choose OK 

The Expression Builder window closes. 

12. In the Defaults area, click the Set 
default value at start of data entry 
option 

The Set default value at start of data 
entry option is checked. 

13. On the Data Entry tab, click the Auto 
advance after field filled option 

The Auto advance after field filled option 
is checked. 

14. Set the RESERVATION_NO field to 
Auto-increment with a default value of 
“00001” 

 

15. In the Skip text box, type .T.  

16. On the Field Rules Editor toolbar, click 

the Save button  

Field rule settings are saved. The Field 
Rules Editor window remains open. 
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Creating a Calculated Expression 
In addition to using simple expressions and auto-increments to define a field rule, you can 
also use Calculated expressions for automatic data entry. A calculated expression can 
compute arithmetic equations such as totals and averages; concatenate data, and more. For 
example, you can create a calculated expression for a table field that is based on other fields 
in the underlying table. You will add a new field (ATT_FULLNAME) to the Attendees table 
that will automatically calculate and store the attendees’ full name by retrieving the first and 
last name once it has been entered for the record. After the value has been calculated, this 
field can be used in forms, browses, and reports. Having the table field automatically 
calculated will save time later because the calculated expression will not need to be created 
every time you want to display the attendee’s full name. The calculated expression for the 
ATT_FULLNAME field is shown in Figure 6.  

*Note: The ALLTRIM() function removes blanks at the beginning and end of a 
character/string expression.  

 

Figure 6: Calculated Expression for ATT_FULLNAME Field 
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To create a calculated field expression: 

1. If necessary, open the Field Rules Editor. 

2. In the Field Rules Editor, select the field in which to enter a calculated expression. 

3. On the Field Types tab, in the Extended field types area, select Calculated. 

4. In the Default descriptive name text box, type a descriptive name for the field. 

5. In the Field description text box, type a description for the field. 

6. In the Calculated field expression text box, enter the expression. 

7. Save the changes to the Field Rules. 

 

 

In the following exercise, you will create a calculated expression for the new 
ATT_FULLNAME field in the Attendees table. 

1. In the Control Panel window, 
right-click the Attendees table 

 

2. From the shortcut menu, choose Edit 
Structure 

The Restructure Table (attendees) dialog 
box opens. 

3. In the last Name cell, type 
ATT_FULLNAME 

 

4. From the Type drop-down list, select 
Character 

 

5. In the Width text box, type 60  

6. On the Restructure Table toolbar, 

click the Save button  

 

7. Open the Field Rules Editor for the 
Attendees table 

 

8. In the Field drop-down list box, select 
the ATT_FULLNAME field 

The Field Types tab is active. 

9. In the Extended field types area, 
select Calculated 

The Calculated extended field type is 
selected. 

 




